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Description
PSYCHLAB windows off-line analysis system allows reduction and modification of data recorded with a PSYCHLAB
measuring system. The analysis system provides conversion of volume physiology waveform data into numeric lists that
allow comparison of performance during the experiment or interview (in addition to raw waveform filtering and export).
It is capable of working with multiple channels of different data types simultaneously.
A number of unique software tools are provided; the ability to section records into relevant time epochs (blocks),
evaluate average, standard deviation, max/min, absolute deviation, removal of Heart Rate artefacts, automatic detection
and quantification of a 'WAVE' shape, and signal averaging (mainly used with EEG evoked potential). Additionally
there is facility to rectify and smooth raw waveform data (such as EMG), and the analysis system allows full automation
of any sequence of functions using 'macro' record and playback mode.

Summary of use
Recorded data are shown in a series of Review windows, at each stage of the analysis process starting with Review#1
which appears when previously recorded data are opened using the third button on the toolbar. Each time a new process
is evoked, a new Review appears. Each Review is independent and has its own menu,
obtained by double clicking within the body of the Review. Any process chosen from
the menu will relate to the data represented in the Review from which it appeared. When
first opened data are shown in Scan mode. No process (including Export) can be
performed until data have been sectioned into blocks; sections of the record of equal
length at chosen time points in the whole record. The block creation process opens a
multi-block Review. From this, any number of processes may be evoked. More than
one multi-block Review can be created from the original scan Review. Process Reviews
show one block at a time, and results are obtained by clicking the OK button, then
moving on to the next block using the forward button. Results are written into the
Results window under control of the Results Format Program (RFP), which runs when
Multi-block
the OK button in the Process Review is clicked. The RFP may be designed to collate
Review
menu
results produced by several process Reviews, when the OK buttons on these Reviews
are clicked in a given sequence. All of the above actions may be recorded in the Macro
window, such that once initially performed, an analysis can be effortlessly repeated on other similar recordings, creating
a table of results for each record. A sequence of records may be opened and analyzed using the batch facility, the results
for each record being gathered in the Results window or automatically stored in files with the base name of each original
recording. PSYCHLAB8 uses short file names throughout, up to 8 characters and extension. FIR filtering and Spectral
analysis, although shown on the Process menu, have not been properly tested and are not recommended for use.

Opening stored data.
PSYCHLAB 8 analysis system is designed to accept multi-channel data from mixed instrument sources at variable
sample rates recorded with the PSYCHLAB measuring system. It permits data conversion into standard ASCII or binary
files, and a variety of data reduction methods designed specifically for physiological waveforms. It is primarily operated
from the Toolbar menu. Data are
shown in 'Review' windows, for which
a 'Review menu' may be obtained.
Data are opened using the 3rd button
on the toolbar or Toolbar menu, File
data, Open data for analysis. The
Toolbar menu

3
default folder shown in the Load raw
data panel may be changed by opening
data from the required folder, then using
Toolbar menu, File data, Save settings
now.
Measured data are stored continuously
so that at any time during the experiment
valid data for analysis exist in the record.
When a record is opened, the entire
record is shown in Review#1. PSYCHLAB analysis system produces a new Review for each stage of the analysis; a
menu is obtained for any Review by double clicking the left mouse button in the body of the particular Review.
Functions in the Review menu relate to that particular Review, whereas functions in the Toolbar menu have global
effect.
The Review menu found in Review#1
(scan) does not show any analysis
options. That is because analysis
functions cannot operate unless they
are presented with even length sections
of data, called blocks. Before data can
be analyzed or exported, the record
must be sectioned up into blocks, even
if these blocks contain exactly the
same information as is shown in the
Scan Review#1. Review menu, Set
blocks. is used to produce a Multiblock Review.

Properties Window.
The properties window shows details of data shown in the particular Review in focus. To
see the properties of a Review, simply click once in the body of the Review and its
properties will be shown. If it is a Multi-block Review, not all the blocks need to be
shown. The particular blocks displayed in a Multi-block Review may be selected by
changing the numbers shown for 'First block shown' and Last block shown' in the
properties window. Click in the Review so that its Properties are shown, then change the
numbers in the First and Last block shown panels, then click back on the Review, and it
will change to show the selected blocks. The same method can be used to change the block
shown in a Process Review, which show one block at a time.

ZoomIn.
It is possible to look in more detail at sections of the scan Review#1 by Zooming in. To do
this, position the cursor to the top left of the area to be viewed, then hold down the right mouse button and drag a
rectangle round the area of interest. The rectangle must cross the axis of each channel for it to be included. Then double
click the left mouse button to get the Review menu, and select Zoom in. When zooming in on a single channel, if the
rectangle is small in height, the zoomin Review will have increased magnification. With the ZoomIn window, or any
scan window which shows less than the whole recording, the <<, <, >, >> buttons may be used to move back or forward

within the record.

4

Review settings.
Settings is found at the bottom of the Review menu for every type of Review and may be used to adjust traces within
that Review. Settings are transferred to any new Reviews that may be created from
that Review.
Settings, Set amplitude. A
magnification adjustment
panel appears in the top left
corner of the Review.
Magnification is adjusted using
the vertical slider, then click
the OK button.
The example shows an SCR trace recorded with SC5, seen unmagnified first, then with magnification set to x 21. Notice the
change in the vertical scale marker. The SC5 trace automatically centers itself within the Review, however other traces
do not do this, such that if there is significant offset from center, this offset can be amplified when magnification is used,
which may force the trace out of view.

Settings, Set Channels. The View channel control allows selection of
whichever channels are wished
to be viewed. Channels are
turned on or off by clicking the
appropriate check box. Then
click OK.

Settings, Set scan time width/offset. This panel only applies to Scan
type Reviews (not block or process Reviews). It allows adjustment of
the time section seen in a
scan Review. Review#1
opens showing the full
duration of the recording.
The ‘density’ of the trace
relates to the number of
actual points from the record
traced out in the Review.
The higher the density, the
more detail will be seen, up to the limit where all points recorded are traced.
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The first example shows a 630 second record sampled at
100Hz with density set at 2500. Notice particularly the event
channel, which shows various randomly interspersed stimuli.
The next example is the same record but with density
increased to 25000. Much greater detail is seen, particularly
noticeable in the event channel where in the first example not
all the brief events showed up. In the last example, density is
2500, but ‘default width’ is selected, so that only a short
section (25 seconds) of data is seen, but every point is shown.
Note that if density is changed in this
panel, a bug stops automatic re-display
working correctly. Click the < button to replenish the display. An alternative control for setting density
is found in Toolbar menu, Options, Initial display density setting.
Settings, Set colors.
A variety of graphic modes are available. All examples shown here use
the RGB option, meaning that primary colors red, green and
blue are used to draw graphs, and the White background
option. Graph color option selected for a Review will be
carried to any further Reviews created from that Review.
Settings, Set graph spacing factor.
Graph spacing factor relates to how
Multiple traces are spaced. Factor 1 allows each trace a completely separate area in the Review space, so that it is
impossible for traces to overlap. Factor 2 allows each trace to overlap the next by 50%. This is the setting used in every
example in this manual, except the two Reviews shown here to demonstrate other graph spacing. The result of factor 2
setting is that the range of each trace extends from the axis of the trace above (or Review top if it is the top trace) to the
axis of the trace below (or Review bottom if it is the lowest trace). The examples below show ERP traces, first using
graph spacing factor 1, then with graph spacing factor 3. Scale range for each trace is determined by looking at the
distance between the top of the Review and the first
trace axis, which is half full scale range. The higher
factors can be useful when there are a lot of channels
which tend to move in somewhat the same direction, as
with ERPs. Allowing higher overlap
increases magnification where large
numbers of traces means that each
trace has very small range.
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Coordinates window.
The coordinates window is produced by positioning the mouse pointer above traces of interest and
dragging with the left mouse button across those traces which are to be evaluated. The cursor must
cross the axis of each trace to be measured. Numbers in the coordinates window relate to time latency
of the cursor and absolute amplitude of each trace measured in appropriate units (in the example these
are micro Volts).
This method may be used on any
type of Review to evaluate traces
within it. The latency measure will
be time from the start of the record
in a scan Review, or time from
onset of event in a block or
process Review where blocks are
produced relative to some event.
The score button has the effect of
transferring values
seen in the coordinates window to the Results text editor. This allows any number of trace values within any Review to
be measured and stored. Regardless of however many channels are selected to show in the coordinates window, the
system will by default format the Results text editor to produce data for all channels, and include the latency value. This
format may be changed by removing lines from the list seen in the Results format program panel ‘ output latency’, ‘

output signal(01)’, etc. Note that each line starts with a space. The results text editor is discussed more fully later in this
manual.

Sectioning data into blocks.
When Set blocks is selected from the scan Review, the Block selection window appears. Normally this will be done from
Review#1, which shows the entire recording, however if Set blocks should be selected from a scan Review obtained by
Zooming in to show part of the entire record, blocks will only be selected from data shown in that Review. At the bottom
of the Block selection window there are two horizontal slider
panels. The first is labeled 'Set block time width'. This is a
crucial setting, whichever method is used to determine when
blocks will be selected. The time width for blocks must be
defined. The setting of time width in seconds is directly related
to the number of samples, as sample rate is constant for each
recording. Move the slider to obtain the desired time width. A minor bug is that if very short time width (<.02S) or preevent interval is used, the Seconds panel may give a misleading display. The samples panel is always reliable, time width
= (number of samples * sample rate). If the block selection window is closed and re-opened, most setting do not change
except pre-event interval, which returns to its default setting. These types of control can be moved in three ways; by
holding the left mouse button down and dragging the square slider, which causes large changes; by clicking within the
gray area between the slider and the left or right ends of the range, which normally causes changes of ten of one hundred
units; or by clicking on the arrow at each end of the range which causes single unit changes. In the case of these block
width and pre-event interval sliders, the number of Samples is changed by moving the slider, and the Seconds display is
calculated by (number of samples) / (sample rate).
'Pre-event interval' is only relevant if blocks are generated relative to events. It allows the block start time to be offset
from the time of an event. A positive pre-event interval means that the block will start before the event; a negative setting
means the block will start after the event.
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The block selection panel provides two ways of sectioning data; on the basis of absolute time into the record, or by
locating events in an event channel and using these to determine the start time of each block. Two panels are provided in
the block selection window. The primary mode of block selection is 'Set blocks relative to events', as most experiments
involve some type of events marked into the
recording, even if these are just buttons pressed by
an operator to indicate the beginning of different
phases. However, if there are no events in a record,
or if it is required to section up the record into
consecutive blocks so that data can be exported, 'Set
blocks at preset times' may be used. To find this
panel, click on the edge which can be seen..
Export of raw data.
This requires data to be first sectioned into blocks.
Usually the entire data is sectioned into blocks using
the Preset Times panel.
Set blocks at preset times. To use this panel, a
block time width must first have been chosen The
panel may be used to select blocks at particular
discrete times, by setting a start time and number of
blocks, then clicking ‘Add’. This may be repeated at different start times if required. It may also be used to section up the
entire record, by setting a start time of 1 and number of blocks 1000, in which case the number of blocks will be limited
to the length of the record. Factors affecting block width are the type of analysis that is to be performed, e.g. for skin
conductance at least 10 seconds is required to see a complete response, or it may be required to use 60 second or 300
second blocks, etc.
When blocking the record for export, block width may be thought irrelevant, but certain criteria must be considered:
1) The last block is unlikely to end exactly at the end of the record and the part of the last block that goes past the
end of the record will contain erroneous information (which may be easily recognizable), but the shorter the
block size chosen, the less such
erroneous data there will be;
2) There is a limit of 999 blocks maximum,
and the system works slightly more
slowly with more blocks.
To recap on how to use this panel:
Choose a block width.
Choose a start time; if sectioning up the
whole record, set this time to 1.
Select the number of blocks required; if sectioning up the entire record, move the slider to the bottom to select 999
blocks. The system will only create as many blocks as it takes to contain the whole data.
Click the add button. If more blocks were selected than it takes to contain the whole data, a warning message is
displayed - cancel it by clicking OK.
Click the View Blocks button.
The start time of each block is seen in the large panel. If wished, this start time information
can be saved to disk from the File menu, and re-loaded for use on another similar recording
(also for use under macro control). To save start times, use the File menu in the block selection
panel, Save preset times.
The last step is to create a multi-block Review with blocks beginning at the designated start times. Click View blocks to
close the block selection window and create a multi-block Review showing blocs of the chosen width beginning at the
designated start times. At this stage, if it is wished to retain the selected block width setting, use Toolbar menu, File data,
Save settings now (it is not recommended to use Toolbar menu, File data, Save settings on exit).
Set blocks relative to events. This panel is designed to allow events marked in an event channel to be used to determine
when blocks are picked out from the recording. Parameters are set so that the event channel can be scanned and blocks
selectively created from the entire recording
.
Set block time width. As with the previous method, block time
width must first be chosen. Factors affecting block width will
relate to the type of analysis that is to be performed, e.g. for
skin conductance at least 10 seconds is required to see a
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complete response, or to observe non-specific
response activity or changes in different phases of a
procedure, it may be required to use 60 second, 300
second or some other block time width. To view
specific response to discrete events, much shorter
block width is likely to be used, e.g. for EEG ERP
around one second is typical and for startle analysis
0.16 seconds is common.
Set pre-event interval. This control is provided to
make it possible to offset the start time of the block
from the time of an event. For a typically EEG ERP
analysis , for example, block width of 1 second
might be chosen and pre-event interval set to 0.1
seconds so that 0.1 seconds of pre-event data and
0.9 seconds of post event data is seen. This control
may be used to offset the blocks from events for
other reasons. It must be remembered that the time
shown is the pre-event interval, not the offset, so
that a positive value means the block starts before
the event and a negative value means it starts after the event.
Set event levels to detect allows specific numbers
that should be found in the event channel to be
specified so that particular events may be picked.
The level prescribed may be one discrete number
(e.g. ‘100’), several discrete comma separated
numbers (e.g. ‘100, 110, 120,’ etc.), ranges (e.g.
‘100 to 120’ to include all integer numbers from 100
to 120 inclusive) or any comma separated
combinations of these. The square panels
‘Individual’ and ‘Ranges’ are provided to
make sure that the format (comma separation
and spacing) of numbers put into this box is
correct. Move the vertical slider to get the
number or range of numbers required, the
click add, then repeat as required. The box
may also be manually edited. Further
examples of setting event levels are given at
the end of this section.
Event channel number. This slider is
provided to allow the channel that is to be used for event detection to be selected. However, PSYCHLAB will
automatically set the event channel appropriately in most cases. It is possible in exceptional cases to use waveform
channels for event detection, but it can be tricky to set the system to detect the particular aspect of the wave that is
required. Normally a stimulus type event channel will be one generated during measurement with commands such as ‘
$measure event stimin’ or ‘ $measure event stimout’ and these are automatically detected by the system.
See times. In the same way as discussed in the previous
section for ‘Set Events at Preset Times’, a list of the times
of each event detected may be seen by clicking this button,
after all, the event detection parameters have been correctly
set.
Deep search. This check box must be checked if the event
is of short duration. Specifically, if the event is shorter than
20 samples (e.g. 200mS at 100 samples per second) then it
should be checked. The event detection system works more
slowly when this box is checked.
For simplicity, the next examples use only short sections of
data from which to create blocks. Normally, blocks are
created from the entire record as seen in Review#1 when
data first open.
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Detect event on onset and
Detect event on offset are
provided to modify the
way the events are
detected. The following
three Reviews illustrate how they work:
Review#3 (as shown in the blue title bar) shows a
random section of raw data with an event recorded in
the lower channel.
Review#5 shows what happens when a block is
selected from this data with block width set to 1
second, pre-event interval set to 0 and Detect event on
onset checked. The block begins at the point where the
event channel changes to the prescribed level to be
detected.
Review#6 is the result when Detect event on offset is
checked. The block begins at the point where the event
channel ceases to be at the prescribed level to be
detected, so the event is not seen. In this case it is the
falling edge of the event, but it does not necessarily
need to be so, if the event changed to some other
value than zero it would still be the end of the level
that was prescribed to be detected. The position of
the block in data can be noted in this example by
observing the EEG.
Blocks may overlap.
This control is provided to deal with a situation
where marks in the event channel may be closer
together in time than the chosen block width. If
Blocks may overlap is not checked, if an event
occurs less than a block width from the time of the
previous event, the second event will be ignored.
This can be useful, as it is often not desirable to
score data relative to an event if there was a
previous event too close to it that might still be
having an effect. Ideally the measurement program
should be designed to ensure that stimulus events
are far enough apart to allow suitable block width to
be chosen when scoring data that will avoid
overlapping events. Review#2 shows a scan section
of data with 3 events which was obtained by
zooming in on part of a much longer record. The
first two events are 2 seconds apart, the 2nd and 3rd
event are 3 seconds apart and there is 2.5 seconds
between the 3rd event and the end of the scan data
section. When blocks are selected using 2.3 seconds
block width and with Blocks may overlap
unchecked, the result is seen in Review#3 showing
two blocks created, because the 2nd event is too
close to the first. The second event is therefore seen
within block 1. When the same thing is done with
Blocks may overlap checked, 3 blocks are created in
Review#4, one for each event. The first block still
includes the 2nd event, so part of the data is
duplicated in the second block, which also shows
this same event.
Set number of blocks per event. This slider is set
to 1 for most purposes. However it can be useful to
generate more than one block for each event
detected, for example when wishing to compare
second by second heart rate from before a stimulus with after the stimulus. By using this
control in combination with Set block width and Set pre-event interval controls, it can
be arranged to produce blocks either side of an event. The scan Review#2 shows a short
section of heart rate data zoomed in from a longer recording. Blocks are selected using 1
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second block width, 5 second pre-event interval and 10

blocks per event as shown in the block selection panel.
Review#3 shows the contiguous blocks that are created,
5 before the event and 5 after it. If these block settings
were used on a complete recording scan, as seen in
Review#1 when data are first opened, instead of a short
section seen in a Zoom in Review, it would produce ten
blocks for each selected event in the record. Data
produced from these blocks could be sorted knowing that
data from the first ten blocks related to the first stimulus
event, the next ten belong to the second stimulus, etc.
Heart rate data would typically be analyzed using the
MEAN function to produce an average IBI for each one
second block, which can easily be converted to heart rate
in the Results Format Program (RFP) using the
reciprocal (HR = 60000 / IBI) where IBI is in mS. These
functions are explained in later sections of this manual.
Another use for this control is in a typical emotion
experiment where there are general ‘stages’ in the
recording indicated by the operator pressing keys during
the procedure. In this instance (and in various other
designs) it may be required to get information for the
entire time after each key was pressed, which could be
any duration. For example, in an interview the operator
presses different keys when the subject is asked various
questions, and waits for a variable period after each
question. Useful data must be produced in even length
time periods. It would be no use comparing the number
of skin conductance responses to each question, for
example, if one question took three times longer than
another. By setting ‘Number of blocks per event to a
large number, the system will fit as many set width
blocks as it can into the period between each event. The
last block for each event will end less than one block
time width from the onset of the next event (this needs to
be considered when selecting block time width, the
longer the block, the more data is likely to be lost
between the end of the last block and the onset of the
next stimulus). In the example shown, the ‘AUDIO’
channel is used to select blocks, with number of blocks
per event set to 255. Review#1 shows a scan of the
entire record, Review#2 shows 10 second blocks created
to fill (as closely as possible) the time between stimuli.
When analyzed, there will be a variable number of
blocks for each stimulus, but because the blocks are of like duration, data can be compared between blocks. An event
code can be included in data for each block, so that it can be easily related to the particular stimulus to which it belongs.
The first, second, etc. blocks for each stimulus can be compared, or data for all blocks for each particular stimulus can be
averaged.
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Set event levels to detect: Examples.
Review#2 is a scan section of a startle experiment
showing a complex event pattern in the bottom
channel 7. The measurement program to produce this
pattern was designed so that there is first a rise to level
68, which designates a particular type of pre-stimulus
in the startle paradigm, then after approximately 6
seconds, the level increases to 132 indicating the onset
of the startle probe, then two seconds after that the
level increases to 204 marking a brief shock stimulus.
The actual experiment produced a series of these
stimulus trials, with slightly varying event levels so
that particular trial types could be differentiated (e.g.
different types of pre-stimulus might be designated by
levels 69, 70, 71, etc., and probes in these trials would
be marked by corresponding levels 133, 134, 135,
etc.). Thus, if event level 68 is put into the Set event levels to detect. Box,

blocks are generated synchronized at the onset of the pre-stimulus only for
that category of trial, but also blocks can be generated synchronized with the
onset of the probe, again only for that particular category of trial. This allows
maximum flexibility when comparing different aspects of data in different trial types (e.g. skin conductance response to
the pre-stimulus can be obtained, and also blink response to the probe). Review#3 shows a 6 second block created with
event level 68 from the single trial shown in scan Review#2, and Review#4 shows a 1 second block created with event
level 132 (the traces have been magnified using Review menu, Settings, Set amplitude. to show the blink in channels 2 &
3 more clearly). Review#6 shows 3 blocks obtained when level 132 is used to select blocks from the whole record
(shown in Review#1).
Save and Load block settings.
The setting of all controls in the Block selection panel, including the values entered into Set event levels to detect, can be
saved and re-loaded using the File menu. Block settings are stored in a file which has extension .BLO. This file can be
automatically called up when PSYCHLAB analysis system is operated under macro control. If the block selection panel
is used when a macro is being recorded, the system will automatically ask for block settings to be saved in a file. Any
number of block settings files can exist, allowing great flexibility when using the system to analyze data from different
experiments. If block settings are loaded for inappropriate data, e.g. block settings which specify channel 10 for the event
channel when the inappropriate data only has 5 channels, an error will occur. It is inadvisable to try to use block settings
saved when analyzing one particular experiment to analyze a different experiment, unless they are very similar,
particularly where sample rate and channel definitions are concerned.
View Blocks.
When all settings are correct, click view blocks to produce a multi-block Review. Data from the relevant parts of the
entire record are re-written (duplicated) into files stored in a folder with the name of the multi-block Review, which
become the source for all process functions evoked from that Review.
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ZoomIn (multi-block Review)
There are two ways that ZoomIn works on Multi-block data.
1) Point to a particular block, then double click the left mouse button and select ZoomIn from the Review menu.
The particular single block will be shown in a new Multi-block Review.
2) Use the right mouse button to draw a rectangle around some particular blocks and channels, then select ZoomIn
to see only those channels in a new multi-block Review.
The >, >>, <, and << buttons may be used in multi-block Reviews that show less than all blocks, to move the selection
within the total blocks, moving one block at a time (>), or by the number of blocks shown (>>). It is not possible to zoom
in on data within a discrete block. The Properties window displays which blocks are shown in a multi-block Review. The
two boxes at the bottom of the Properties window may also be used to change which blocks the Review shows. These
two boxes may be edited by typing in them. When the Review is brought back into focus by clicking on it, blocks shown
will change to those described in the Properties window.
This way, an original multi-block Review may be changed
to show only a range of the total number of blocks, without
the need to use ZoomIn, which creates a new Review.
However many blocks are
shown in a multi-block
Review, Process functions
operate on the total number of
blocks, not the number shown.
Zooming in or showing only a
range of blocks is used so that
blocks may be viewed more
clearly, for example to allow
manual screening of blocks.
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Include.
Include allows individual blocks to be included or excluded from processing. At the
top of the multi-block Review, each block is numbered. If the number shown is
black color, the block is included. If the number shows red, the block is excluded.
To change the inclusion status of a block, point to the number and click.
Include/exclude is mainly used only in EEG ERP processing for block screening,
but does have a few other useful applications. With ERP processing, the number of
blocks used to generate the Average ERP may vary without affecting the format of
results data (ERP wave or aspects deduced from it). With other types of data,
normally the number of trials in the experiment determines the format of results
data – one line of data relates to each trial. In these circumstances it is undesirable to alter the number of blocks that are
processed by excluding, as it affects the number of lines of data in the results file which normally needs to remain
constant to suit further cross subject analysis.
Include all blocks and Exclude all blocks may be used to set all blocks included or excluded.
Include, Manually select blocks is a redundant feature from an earlier PSYCHLAB version. Block include status is
most easily set by pointing and
clicking as described above.
Include, Screen out-of-range
blocks. This may be used to
automatically exclude blocks
that have values which fall
outside a given range. It is most
frequently used with EEG ERP
data, to exclude blocks which
have artifact or blink. Only
channels which are selected will
be screened. A channel is
selected if the black number
which shows on its left axis is 1. Screening range is set in the Process settings panel, which is obtained in Review menu,
Process, Set parameters. With EEG data, screening range would often be set to just within the maximum range for
particular channels. An indication of channel range is given with the scale marker to
the bottom right of each Review. In this case the range is 200uV, so settings of + 90
uV and – 90 uV are appropriate. The scale marker shows the range of the first
channel that is selected. EEG recorded with EEG8 amplifiers has scale for all
channels set the same. If an eye channel is recorded, this would be the channel to
use for screening. If no eye channel is recorded, all channels could be included for
screening, with the range set just within maximum (e.g. +/-99 uV). Note that the
EEG8 amplifier has a manual attenuator on eye channels which means that actual
eye voltages may be double (50% setting) or 5 times (20% setting) scale voltage
shown, but the screening range should still be set with respect to the scale voltage
shown.
When the screening range has been correctly set, Review menu, Include, Screen out-of-range blocks may be used.
Blocks will be screened in turn, and the block number at the top of the Review will change color for excluded blocks. If
no blocks appear excluded after screening, check that the screening range is in fact within the maximum range; try
reducing screening range until some blocks do change color just as a
check. Make sure that relevant channels are selected. If all blocks are
unexpectedly excluded, check that the event channel is not selected. Use
Review menu, Include, Include all blocks. to reset all blocks before retesting screening.

Include, Select blocks by event category.
The main purpose for this function is for a future development in which
the measuring system might generate data already in blocks, instead of
the continuous recordings that are the present mode (October 2000).
Otherwise, one or more multi-block Reviews using any event selection
can be created from the normal Block selection window. Review menu,
Include, Select blocks by event category. may be used to exclude particular blocks where an original multi-block Review
contains blocks with various event categories. Blocks should be reset using Review menu, Include, Include all blocks.
before using this method for excluding particular blocks (it excludes only blocks that are already selected, it does not re-
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include blocks that are already excluded). If Create new Review. is checked, a new multi-block Review appears
containing only the subset of blocks.
Include, Select block by user defined pattern. This may be used to include particular blocks to a pattern described in a
text file. It can be useful when recorded event codes do not discriminate necessary
blocks, but trial patterns are known. Necessary blocks may be included or excluded
from all by loading in the appropriate
pattern from disk file. If the file does not
contain as many lines as there are blocks,
remaining blocks will be deselected. If it
contains too many lines, the last lines of the
file are ignored. Review#2 shows blocks
selected using the file shown in Notepad
editor to the right. Each line contains just
one character, 1 or 0 for include or exclude.
Certain process functions may not obey
Include status. Average, used for EEG ERP
analysis, only averages included blocks and
leaves out excluded blocks, but other
functions may process all blocks regardless

of include status. If only included blocks
are required to be processed by other
functions, a new multi-block Review
may first be created containing only the
required included blocks.
Include, Make new Review of only
included blocks. This may be used to
create a multi-block Review from an
original one, containing only the blocks
that were included in the original. The
example Review#3 is a new multi-block Review created using the Pattern example above. Note that blocks in the new
Review do not retain the same block numbers used in the original Review.
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Processing data.
Processing operations are designed only to work on data in blocks, which provides processing algorithms with uniform
length data on which to operate. This has the advantage that like information is produced for each block, allowing valid
statistical comparison.
Channel Selection.
Process functions operate only on channels that are selected. Selected channels
are shown with 1 on the axis just to the left of the waveform area. Unselected
channels are shown with 0. To change a channel’s selection status, click on the
selection indicator (i.e. click on the 1 to change it to a 0, and vice-versa).
Almost invariably, the event channel should not
be selected when processing data, as it contains
a different type of data to physiology
waveforms. However, the event channel can be
made to show in process Reviews by checking a
box in the Process settings window.
Set parameters.
It is important to select channels before
going into the Set parameters panel, as
when a
Process
settings file
is stored, it
includes
the current
channel
selection.
The
Process settings
window is opened
using Review menu,
Process, Set
parameters. The settings in the Process settings
window relate to the particular Review from which
it was opened. PSYCHLAB allows different Process
settings to be used in different Reviews. If the
Review is a multi-block Review, the settings for that
Review will be used for any process functions used
on that multi-block data. The settings that show
when the window is first opened are the default
settings. These default settings may be permanently
changed by altering process settings, then closing
the Process settings window and then selecting
Toolbar menu, Save settings now. However, there is
an alternative way to change settings to a stored
pattern, by using Process settings window menu,
File, Load process settings. This way of loading in
process settings allows different settings to be loaded from various files, whereas there can only be one set of default
settings stored using Toolbar menu, Save settings now. If inappropriate settings are loaded, it may result in an error. If
this occurs repeatedly, cancel the error, then use Toolbar menu, Save settings now, so that default setting suit the data.
The Process settings window is divided into sections relating to particular processing algorithms. These are discussed
within descriptions of each particular process function.
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Process, Average.

This function performs signal averaging of the type used with EEG evoked potential. Like points of each block are
averaged together, so that random aspects of data tend to cancel out, whereas effects relating to a stimulus synchronized
with all blocks will be amplified. Only selected channels are included in the resulting Average Review. Note that before
opening raw data, it is possible to invert data in Toolbar menu, Options, Invert data. This can be used to orient the ERP
wave positive or negative up, as preferred. Blocks are then created, and before EEG data are averaged, normally they are
screened using Include, Screen out-of-range blocks. The panel in the Process settings window which has bearing on the
Average function is, therefore, Select screening range. The channel/s to be used for screening should be selected, then
the Process settings window opened from the multi-block Review using Review menu, Process, Set parameters. The
Screening range panel should be appropriately adjusted, Process settings window closed, before using Review menu,
Include, Screen out-of-range blocks. Review#2 is an example EEG Multi-block Review with screened blocks using the
eye channel with screening range set to +/-90uV. Channel selection must now be changed to select all EEG channels (but
not the event channel). Then, Review menu, Process, Average can be used, the result seen here in Review#3. Notice that
while the Multi-block Review shows 40 blocks, the Average Review is Average of 24 blocks, only the blocks that were
included.
The four buttons in the top left corner of the Average Review have
different uses now; they are a convenient way to change magnification,
which can also be done using Review menu, Settings, Set amplitude.
ZoomIn cannot be used on average traces.
At this stage the following options exist for use on the average traces:

1) Export average data using Review menu,
File, Export Review data as. Before using this
function, settings in Toolbar menu, Export.
should be checked.
2) Score the traces using the coordinates
window, using the same method described
near the beginning of this manual.
3) Wave process the average data, using Review
menu, Process Wave. Normal rules for the
wave function apply, however ERP traces are
genera
lly too
compl
ex for
the
wave
functi
on to
be
able to
reliably detect desired aspects.
4) User Process the average data. Review menu, Process, User process. provides a
wide range of possibilities using the Results Format Program (RFP) language to automatically manipulate ERP
data. In its simplest mode, the OK button can be clicked in the User process Review, Cancel button clicked in
the Open RFP panel, and numerical information for each trace flows into the Results window. Pre-stimulus
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Mean can be produced by more complex RFP programming and even automatic scoring of traces may be
possible.
User Process was employed to produce ERP pre-stimulus mean for the data shown in the above example as
follows:
The Results window was opened from Toolbar menu, Window, Results. The RFP seen in the RFP program
section of the Results window called EEGPRSTM.RFP was loaded from disk using Results
menu, File, Open format program. When the OK button in User process Review#4 was
clicked, the pointer moved across the 1000 point block, running the code seen in the RFP
section of the Results
window, for each
point, starting from
point 0. The top part
of the code
accumulated the value
of each point for each
channel in variables a1
thru a8, and counted
the number of samples accumulated in
variable n1. After 100 points the top line in the RFP caused a jump to the FINISH subroutine. Data in this
recording was sampled at 1000Hz, so 100 points is 0.1 seconds, which was the pre-stimulus period arranged
when blocks were originally created. The FINISH subroutine first sets function ‘pointer’ to ‘sblo’. RFP function
‘sblo’ returns the size of the block in points (i.e. 1000). Function ‘pointer’ relates to the position of the pointer
that is seen to run across the Review as the RFP runs for each point. A full list of commands and functions for
the RFP language is given in the Results Format Program section of this manual. ‘ Pointer = sblo’ has the effect
of jumping the pointer to the end of the block, so that no more points are processed. The rest of this subroutine
calculates average for each channel, outputs that information into the Results area, terminates the line in the
results area so that next output will be on a new line, and resets the variables to zero in case the OK button
should again be clicked.
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5) Compare or Subtract Average traces with other Average traces. This
is performed by generating more than one Multi-block Review and ERP
Reviews from original data. Review menu, Edit, Copy. may be used to
put traces into the clipboard; then the various paste options used to
Superimpose, Add, Subtract, or Replace. The example shows two ERPs
generated in an oddball paradigm, rare (Review#5) and frequent
(Review#4), then the two superimposed (Review#6), and finally the
frequent subtracted from the rare (Review#7).
6) Grand Average. This is performed with Review menu, Edit, Copy to
File. ERP traces for each subject are generated and copied to file. When
the last subject is done, Review menu, Edit, Paste merge add from file.
is used to add the ERPs from all subjects to the last subject’s ERP. The
total number of subjects added must be counted. Finally, Review menu,
Edit, Reduce waveforms is used to divide accumulated values by the
number of subjects, producing a Grand Average which is correctly scaled. This
may then be Copied to file in the Edit menu, or the Grand Average can be
processed in any of the other ways mentioned here.

Process, Mean.
Review menu, Process, Mean. may be used to produce:
1 Average of all points in one block (referred to as Mean to avoid confusion with signal Averaging discussed
above).
2 Standard deviation of all points in one block.
3 Confidence measure for Heart Rate data in that block, based on out-of-range value detection and correction.
4 Maximum value encountered in that block.
5 Minimum value encountered in that block.
6 Absolute deviation of all points in that block.
Typical uses include average SCL,
average, standard deviation and
absolute deviation of heart rate over
long time epochs, average and
maximum pre-probe EMG in startle
trials, average and maximum facial
EMG in longer time epochs of
emotion data. The example Review#3
has SC, Heart rate (HR) derived from
the EKG in hardware using an Interval
Timer (which measures IBI in
milliseconds), Respiration and EMG
traces. Fifteen contiguous one second blocks are produced with 5 before the stimulus and 10 after it. Appropriate
measures for use with the Mean algorithm are SC (SCL), HR (IBI) and hardware rectified/integrated EMG. If raw EMG
is recorded, Process, Rectify and Process, Smooth may be used before the Mean function is applied. Other measures such
as pulse and EKG are AC waves that alternate about zero. Mean of these measures would tend to zero and have no
usefulness.
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Before selecting Review menu, Process, Mean. within the Multi-block Review, appropriate channels must be selected.
The Mean Review produced shows the first block. Most traces seem flat in the one second block, as SC and IBI are slow
changing variables.

The Process settings
window has one panel
for use with the Mean
function; adjustment
relating to IBI, from
which Heart Rate is
derived.
IBI artifact rejection.
The maximum and
minimum settings in this panel determine a range within which IBI values are
acceptable. Outside that range, IBI values are omitted from the Mean calculation.
The example recoding was made at 100 samples
per second, so each one second
block will contain 100 samples. Let us suppose
that IBI were out of range for a
quarter of the time in one block. This would
happen if IBI were originally
within range, i.e. between 500mS and 1500mS
(120BPM and 45BPM) but a
movement artifact occurred causing the Interval
Timer to mis-trigger three
quarters of the way through the block causing a
new IBI reading that was too
low, i.e. below 500mS. If Omit bad timer values.
was checked in the Select Mean
Parameters panel, the Mean function would calculate average IBI by adding together the value of 75 samples and
dividing the result by 75. A number of 25 would show as Last no. out-of-range. All other Mean function data (Standard
deviation, max, min, absolute deviation) would also be based on 75 points. If the box were not checked, the Mean
function would use all 100 points, including the bad ones, to make the calculation.
The last no. out-of-range. value is one of the items produced by the Mean algorithm that is available as result data
(Dat3), to be used as a confidence value, where zero is 100% confidence, higher values indicate less confidence up to the
number of points in a block (in this case 100), indicating that IBI data is completely unreliable.
To get numerical result data from the Mean Review, click the OK button. This
opens the Results window, and shows a panel for selecting data. A panel appears in
the Results window which may be used to select data produced by the Mean
algorithm. The panel has italicized headings numbered 1 thru 7; these should be
followed in turn. 1, Select header information for line. Check the boxes underneath
this heading for information that will
be headed to the beginning of each line
of data produced. Block number is
useful to help identify each line in the
results file. Event value will help
identify which trial results data
belongs to. It returns the value of the
event that triggered the block selection
process to generate the block/s.
Next, click on the button labeled 2,
Add. This will generate the first
section of code in the Code generated.
panel. Next, 3, Select channel number.
Moving this slider up and down
changes the big number seen next to it.
To start with, no number may appear.
Mover the slider up one and back
down one, and the number of the first
channel will appear. 4, Select required
output per channel. For the selected
channel, select items of data required.
If it is the last channel, also select
Terminate line after this channel. This
will have the effect of creating a line break in the Results file after data for each particular block. When correct items are
selected, click 5, Add.
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Repeat stages 3 thru 5 for each channel, with consideration for the type of data that is appropriate for each channel.
For the IBI channel, include Bad value count, if this is activated in the Process settings panel. For EMG, maximum is
often considered useful. Bear in mind when selecting data that the more information included for each channel, the more
tedious it can be to decipher results data.
Finally, click on the button labeled 7, Close (transfer code to RFP). This pastes the code from the code window into the
RFP program area. If code already existed there, the new code would be amended to it in such a way that both sections of
code would operate at appropriate times. This is done by the lines ‘ select by Review#’, and ‘ REVIEW#4’. The top line
causes program execution to jump to the section of code that relates to the Review for which the code is intended. When
the code in the RFP area is amended, a prompt asks whether to save the program. Generally it is advisable to do so, so
that it may be used again.
After that, another
prompt appears ‘Now
press the OK button
again’. The reason for
this is that originally,
the OK button of
Review#4 was clicked,
with the purpose of
putting data into the
Results window. But,
because no RFP
existed, instead of
being able to run the
RFP to output data in the desired format the system produced the Set up panel to allow a program to be created. Now the
program has been created, this prompt reminds to click the OK button again so that this time data will actually arrive in
the Results window. The alternative to using the Set up panel is, before initially clicking the OK button in the Mean
Review, open the Results window from Toolbar menu, Window, Results. then either type a program directly into the
RFP area, or load one from disk.
Clicking the OK button produces the first line of data in the Results window as seen in
the example above. The next stage is to move Review#4 on to the next block. This is
done using the > button. Block 2 appears, and the Ok button can be clicked again to put
data from block 2 into the Results window. This is repeated for 15 blocks, producing 15 lines of data in the Results
window as shown below.
The meaning of numbers in each line relates to the order of ‘output ‘ statements in the RFP, i.e.
block no, event value, average of channel 1 (SCL), average of channel 2 (SCL), average of
channel 5 (IBI), number of out-of range timer values for channel 5, average of channel 8
(EMG), maximum of channel 8. Data in the Results area can be saved to disk using Results
menu, File, Save results. The setting of Results menu, Output direction is important. If it is not
set to Send Output to Results Window, each line of data will go automatically into a disk file
named as the Raw data file but with .RES extension. Only one line of data will appear in the
Results window. The RFP is described in more detail later in this manual.
The example demonstrates analysis of 15 one second blocks
around a stimulus. The data used in the example showed just
one stimulus – blocks were created from a zoomIn on a short
section of a whole recording. In the long record with many
trials, there would be 15 blocks produced around each
occurrence of specified stimuli. The
1
255
5.907967
3.613079
1094.43
0
same method can be used to analyze
2
255
5.900603
3.606997
991.25
0
the whole record; data in the results
3
255
5.894599
3.606997
969.5
0
window can be translated knowing
4
255
5.887159
3.600759
1012.88
0
that each stimulus produces 15 lines.
5
255
5.881002
3.598999
1014.51
0
6
255
5.877236
3.596761
854.98
0
Stimulus event values used when
7
255
5.870998
3.591003
820.65
0
setting blocks may have a range of
8
255
5.908917
3.629719
904.07
0
values as specified in the Block
9
255
6.100837
3.757159
922.8
0
selection window, Set event levels to
10
255
6.292043
3.841643
888.06
0
11
255
6.396597
3.888601
923.61
0
detect. box. The value of each
12
255
6.443161
3.910443
1002.4
0
stimulus will be seen in the Event
13
255
6.432195
3.896279
1009.65
0
column of the results file, which
14
255
6.384681
3.864763
941.25
0
may be helpful when translating the
15
255
6.325317
3.832358
873.68
0
table of results.

8.601685
9.962158
9.771851
11.59631
6.769897
13.89722
18.37891
44.67639
38.83545
26.23596
20.89441
14.0365
11.97473
9.012573
8.718872

12.56104
20.76416
16.30859
22.90039
16.18652
21.3501
38.48877
50
50
39.08691
36.82861
23.41309
19.6167
16.24756
11.12061
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It is laborious to have to click the OK and > buttons for a
large number of blocks, and the Macro feature can be used
to automate this, so that all blocks are processed
automatically. Macro is discussed further on in this
manual.
In the RFP, remarks are automatically placed at the end of
certain lines to help with understanding of how the RFP
operates, e.g. ‘ average seen at the end of line
output dat1(01)
Any characters after the single inverted comma on a line is a remark; it is ignored by the RFP interpreter and has no
effect. Remarks generated by the Set up. panel for Mean may not be the same as those shown in the example. This is a
bug with the program (October 2000).

Full list of RFP language commands:
GOTO
GOSUB
RETURN
IF… THEN…
OUTPUT [value]
Send value to the results window or output file as text with 13 character format.
OUTBIN [value], [format] Send value to binary file. Two byte integer format is used if format is not specified.
BEEP
Make a brief sound using the default warning noise.
BREAK
Used in debug mode to halt RFP file execution.
END
Used to exit execution at the end of a file, or to exit at any point.
MARK
Draw a line at current pointer position in a User Process Review.
PRINT USING [format] [value]
Send value to results window or output file as text using defined format.
DISPLAY [value],[vertical],[horizontal]
Print value in body of User Process at vertical and horizontal position.
SELECT BY REVIEW# Jump to the specified REVIEW# label (e.g. REVIEW#3). Label must be upper case.
SELECT BY CHANNEL#
Jump to the specified CHANNEL# label (e.g. CHANNEL#2), upper case.
The above commands are used in the direct context, e.g. if x = y then BEEP, or just BEEP.
LATENCY
KEY
INCLUDE
HOUR
MINUTE
POINTER
DAT1 thru DAT6
ABSTIME

Function that increases in time increments of data sample interval.
Change value produced when function key pressed in User Process Review.
Change include/exclude status of the current block in a User Process Review
Change the hour value produced as record time.
When absolute time is selected, the minute of the record time at present position in data.
Position in data in a User Process Review. Scans from 0 to number of samples in block.
Data produced by processing algorithms WAVE and MEAN.
Used as [value] in the OUTPUT command; presents absolute time in results text.

The above commands are used in the context that they may be set, e.g. LATENCY = x.
TIME
KEY
LATENCY
RANDOM
SUBJECT
GROUP
PARAMETER
NCHAN
NBLOCK
SBLOCK
WIDTH
RATE
BLOCK
INCLUDE
REVIEW
OFFSET
MONTH
DAY

Returns the time of the start of a block in User Process Review. Cannot be changed.
Returns the last function key value pressed in User Process Review.
Returns current time value resolved to sample interval. Latency can be changed.
Returns a random value in range 0 to 255.
Returns the subject number specified in Subject Details panel when data record was made.
Returns the group number specified in Subject Details panel when data record was made.
Returns the parameter value specified in Subject Details panel when data record made.
Returns the number of channels in the record.
Returns the total number of blocks.
Returns the blockwidth as number of samples.
Returns the blockwidth as time in seconds.
Returns the sample rate used when the record was made.
Returns the number of the block currently being processed.
Returns the include/exclude status of the block currently being processed.
Returns the number of the Review currently being processed.
Returns the time offset as set when blocks were created
Returns the month when the record was made.
Returns the day when the record was made.
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YEAR
Returns the year when the record was made.
EVENT
Returns the event value used to find the particular block.
CHANNEL
Returns the channel number of data being produced by the WAVE algorithm.
POINTER
Returns the current point position when block data are scanned in User Process Review.
SQR [value]
Returns the square root of value, e.g. x = sqr y Parentheses are not required.
SIGNAL(nn)
Returns the value of channel nn at current pointer position in User Process Review.
DAT1(nn) thru DAT6(nn) Returns output from WAVE or MEAN algorithm. nn must be two characters, e.g. x1, 03.
GAIN(nn)
Returns range setting of channel nn set on the amplifier when record was made.
Note that in all cases, where a subscript is used in parentheses shown as nn, two characters are required. This can be
either a constant, e.g. 01, 02, etc. or a variable e.g. a1, z9, etc. In all other cases, however, leading zeros are not to be
used when specifying values as constants, e.g. use .1 not 0.1.

Process, User Process.
Review menu, Process, User Process may be used to allow processing of
data using logical commands in the RFP area. When the OK button in the
User Process Review is clicked, it causes the RFP file to run once for every
data point in the Review, starting at the beginning of the Review.
The above list of commands may be used in the RFP.
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Process, Wave.
Results menu, Process, Wave. is a very useful tool. It
was originally designed for detecting Skin Conductance
responses, but by making use of the adjustable
parameters provided in the Process settings panel, it
adapts to uses such as R wave detection for calculating
Heart Rate, Respiration wave counting for calculation of
respiration rate, Pulse amplitude
measurement, quantification of
blink amplitude in startle trials,
etc.
The Wave detection system
works by applying the following
test at each point along selected traces:
1) A positive slope is detected if a given number
of consecutive data points have progressively
increasing value, without any instances of
intermediate points being of lower or equal
value to their predecessor.
2) When slope is detected, peak is established
when a given number of consecutive data points
have value equal to or less than their
predecessor.
3) When the slope and peak are detected, onset is
recognized by tracking back from the first point
of the slope to establish the position where a
given number of data points have value equal to
or less than their predecessor (i.e. the trace is
flat or descending).
4) The difference in level between the onset and
peak is compared with a minimum
criterion and if less, the wave is not
detected.
Channels for wave processing must first be
selected in the multi block Review before Review
menu, Process, Wave is used. A single block is
displayed in the
Wave Review, with
markers placed
above and below
the trace, showing
the onset and peak
of any waves
detected. Generally,
a Wave Review will
only be used to process one type of data at a time.
In a recording with several different traces, one
Wave Review would be used to process Skin
Conductance, a separate Wave Review would be
used to process pulse amplitude, etc. The reason
for this is that Process Settings for the Wave
Review would almost certainly need to be
different for various types of trace. Process
settings may be set in the multi block Review
before the Wave Review is created, and settings will be carried forward to the Wave Review. They can also be adjusted
after the Wave Review is created by selecting Review menu, Process, Set parameters. from within the Wave Review.
When changed this way, the Wave algorithm is re-applied to data seen in the Wave Review immediately the Process
settings window is closed.
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Effect of Wave settings.
Manual score only
check box disables
the automatic scoring algorithm. In this
mode, the record can be manually
scored: Place the mouse pointer above a
trace and drag the left mouse button
across the axis of the trace, then release.
Then grab the score marks and move
them to the desired position. This may be
repeated as often as necessary. To delete
any unwanted score markers, click the
right mouse button on the onset marker. When the block is scored satisfactorally, click OK and
proceed in the same way as described for
automatically scored blocks.
Allow onset at block start check box
allows a wave to be scored if the onset
marker cannot be correctly positioned
because the wave is too close to the beginning of the block. The box
would be checked in cases where the purpose is simply to detect waves, e.g. for counting in HR or RR analysis, or
counting spontaneous SC fluctuations. It would not be checked in cases when the time of onset of the wave is important,
such as for specific time windowed SCR or perhaps
analysis of startle blink data, where the response should
not be scored unless the onset meets a latency criterion.
Compress wave slider relates to:
1) Slope of the wave, i.e. rate of change.
2) Sample rate used to collect data.
3) Frequency of the wave to be detected.
These three parameters are all linked. The slope will be
steeper if the frequency is higher, or if the sample rate is
slower. The Compress wave slider allows the number of points that the algorithm sees for its four step wave detection to
be changed. If it is set to 1, Wave detection uses every data point in the block. At 20, it
looks at the first point in the block, and ignores the next 19 points, using the 20th point as
the next for determining integrity of onset slope etc. The reason for using compression is
that if there is a very gradual slope, the slope detection algorithm will cancel if it finds any point that is not greater than
the previous one. This is highly likely to occur in a very shallow slope. Ideal settings for the Wave detection system
(WDS) are shown in the table. For SCR detection in a record recorded at 100 samples per second, set compression to 20,
etc.
SCR
5 samples per second
Peripheral Pulse
20 samples per second
EKG
100 samples per second
Respiration
5 samples per second
Startle blink
200 samples per second
Four vertical sliders adjust each of the four stages of
the WDS algorithm. The first slider determines the
number of points used in
detecting onset. A relatively
low setting for this usually
works well. The second
slider adjusts the number of
points used to determine the slope. The slope is the
first aspect of the wave to be detected, so this slider
has profound effect on sensitivity. In the first example,
this slider is set to 0, which means that any place
where there is an increase in the trace, WDS will pass
the slope test. In the second example, this slider is set
to 3, which gets a more sensible result with these SCR
traces. There has to be a degree of compromise in
setting these sliders, best found by trial and error on the particular data. Run through the blocks to see how many Waves
are missed out, or how many undesired score marks appear. When a block is found which is scored incorrectly, change
slider settings to get the desired result then go back to see how it affects other blocks. The third slider determines the
number of points that must comply for the peak to be established. The fourth slider determines minimum response
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amplitude, i.e. level at peak minus level at onset. This is
calculated as a percentage of full scale range. In the
examples, the scale marker in the bottom right of the Wave
Review shows a vertical scale of 0.4 microSiemen. The
height of this scale marker is ¼ of the full scale height
available for each channel (e.g. the red channel has a scale
range from the top of the Review to the axis of the green
channel). Thus, the full scale range is 4 times the value
given for the scale marker, 1.6 microSiemen. If the fourth
slider is set to 0.1%, the minimum allowable wave
amplitude will be 0.0016 microSiemen. SCR analysis often
requires a given minimum amplitude to be used, for example 0.02 is commonly used. To achieve 0.02 with the example
recording, the calculation would be (0.02/1.6)*100 = 1.25%. A compromise of 1.2% or 1.3% would have to be used as
the slider only resolves to one decimal place.
Data produced by the Wave Review. Other controls in the Wave process settings panel relate to how data appear in the
Results window. These controls are duplicated for view in the Results set-up panel, but cannot be changed there. The
Process settings window must be opened from the Wave Review to change these settings.
The Wave Review can produce the following information.
1) Onset level of each wave.
2) Onset latency (from block stimulus event) for each wave.
3) Amplitude of each wave.
4) Total amplitude of all waves in each channel.
5) Count of waves in each channel.
6) Peak latency of each wave.
Show zeros if no wave ensures that if no wave at all is detected in a particular
channel, WDS will put zero numbers into the Results area, rather than leaving fields
blank.
When satisfied with WDS settings, click the OK button in the Wave Review. Set up
Output for Wave function. Panel appears in the Results window. Resize the results
window if necessary to clearly see the panel. Follow the numbered italicized headings
in order. 1) Header information is data that will appear at the beginning of every line
of results. 2) Add must be clicked when satisfied with the header selection.
3) Select required wave information allows selection of the 6 pieces of information produced by WDS. Normally, either
individual information will be
required or summation
information (total of all waves
and total wave count), but not
both. Summation information is
generally used when nonspecific information is
collected, such as SC NSR in an
emotion study, Pulse amplitude,
Respiration rate, EKG for HR.
Individual information is likely
to be required when a specific
response to a stimulus is
measured, such as SC SR or
startle blink. The channel
number field may be helpful to
help identify which field in the
results data relates to which channel, particularly if a separate line is used for each channel.
4) Select format determines how information will flow into the results window. It controls the positioning of CR LF (new
line) characters in the results text, dividing data into separate lines. Normally, if only wave totals is selected (in which
case only the two summation fields would be checked), one line would be used for each block, because there will always
be the same number of fields produced, regardless of how may waves are detected. The same is true if individual
information is required, as in a specific response study, when First wave only is selected which means that although
wave markers will be seen for all waves, only the first one will be sent to the Results area. If All individual waves is
selected, it would be normal to terminate the line after each wave. In this case the size of the results file will vary
depending on how many waves are detected. This mode is seldom used.
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5) Add is clicked when the above information and format are correctly set, then 6) Close (add code to RFP) must be
clicked. At this point a prompt may appear asking to save the RFP. Generally it is useful to do this, so that the settings
just produced can be more easily loaded directly from disk for a future analysis. If a suitable RFP has already been
opened in the Results window, the Set-up panel will not appear when the OK button is clicked in the wave Review.
Now, when the OK button in the Wave Review is clicked again, the RFP runs once for each wave in the first channel,
and then once for each in the second, producing lines of data for each wave in the Results window:
Fields (columns) of each line in the results window have meaning as shown in the list:
The RFP that was generated by the set-up panel is also shown; the way the RFP
works begins to be revealed. The RFP can be directly edited to adjust the format of
Block number.
output data.
Event code for that block.
Channel number.
With the Process settings panel changed for First wave only., as shown below, and
Wave onset level.
the set-up panel changed to put a new line between each channel rather than
Wave onset latency from
event.
Wave amplitude.
Wave peak latency.

each wave, when the OK button is
clicked the results window appears
thus:
The field list is the same as before, but only two lines are produced for each block, one for channel 1 and one for channel
2. The RFP generated by the set-up panel is slightly imperfect as it generates a first line which has only header
information in it. This short line could just be ignored, or the program could be edited to improve its operation.
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